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ATTENTION!

This manual must always be available to operators of the 
devices described here. 

	 Always make sure that you have the latest version 
of the manual, which is available for free download from the 
GEFRAN website (www.gefran.com). 

Installers and/or maintenance personnel are required 
to read this manual and to precisely follow the instructions 
contained in it and in its attachments. 

GEFRAN will not be liable for any damage to persons 
and/or property, or to the product itself, caused by failure to 
follow the instructions and observe the warnings given below.

This manual and its attachments may be freely reproduced 
as long as they are not changed in any way and every copy 
contains this warning and the declaration of ownership by 
Gefran S.p.A.

INSTALLATION AND USER MANUAL
 

code: 80991 - 10-2012 -ENG

GF_VEDO SL
Controller and integrated operator Terminal
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Warnings and safety

Printing conventions used in the manual

PREFAcE

While all the information contained in this manual has been 
carefully checked, Gefran S.p.A. accepts no responsibility 
for the possible presence of errors or for damage to persons 
and/or property caused by the improper use of the manual.
Gefran S.p.A. also reserves the right to make changes to 
the contents and form of this manual and to the characteri-
stics of the devices illustrated at any time and without prior 
warning.

The installation of the devices illustrated in the manual must 
be carried out by qualified technicians in compliance with 
the laws and standards in force and in agreement with the 
instructions contained in the manual.
If the GF_VEDO SL is used in applications with the risk of 

damages to persons, machinery or materials, its use in con-
junction with alarms is essential.  
It is advisable to envisage the possibility of checking the in-
tervention of the alarms during regular operation.

Before interacting with the Controller and built-in Operator 
Panel, the operator must receive full training in the proce-
dures of operation, emergency, diagnosis and maintenance 
of the system.

Pay attention to the use of the following symbols.

Highlights particularly important information which
influences the correct operation of the product or 
of safety or an instruction which must absolutely 
be followed.

Highlights a risk condition for the safety of the in-
staller or the user, due to the presence of dange-
rous levels of voltage.
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CAN Controller Area Network, also known as
CAN-bus, is a standardised  bus that
enables the devices to communicate
with each other. 

CANopen CAN communication protocol.
Protocol specification for devices used in 
automation systems.

Work cycle Fraction of time that represents the active 
state of a device, circuit, etc. in relation to 
the total time considered.

Data logger Enables the storage of information for fi-
ling records or further processing.

Duration of 
settlement

Time required for the output value to reach 
and remain above 90 % of the final value.

Encoder Rotative position transducer.

Electric 
resistance 
extensometer

Sensor that transforms small dimensional 
deformations of a body subject to me-
chanical or thermal stress in changes of 
electric.

Ethernet Standard for local networks  (LAN).

FLASH Non-volatile memory in the solid state.

FRAM Non-volatile RAM faster than the Flash
memory.

FTP File Transfer Protocol. 
Allows the upload and download of data
files between the controller and other
digital devices.

LSB Least Significant Bit. 
It defines the minimum resolution of a me-
asurement.

LSS Layer Setting Services.

Modbus Open serial communication protocol, de 
facto standard in communication betwe-
en industrial electronic devices. 
Modbus RTU is the most common imple-
mentation of this standard, Modbus TCP/
IP is that specific m for Ethernet networks.

Opto isolated Circuit configuration which, through an 
electronic component called an opto-iso-
lator, allows the transferral of a signal
between two circuits while maintaining	
galvanic separation.

PID Regulation algorithm.

PLC Programmable Logic Controller.
A digital computer specialised in the ma-
nagement of industrial processes.

PWM Pulse-Width Modulation. 
Technique for controlling power towards
electric devices.

RAM Random Access Memory 
Electronic memorising device which ena-
bles the reading and writing of data.

Glossary

RS-232 Standard which defines a low-speed se-
rial transmission interface for the exchan-
ge of data between digital 
devices, such as modems.

RS-485 Standard, at physical level, for serial con-
nection with 2 wires.

SD Card Card for memorising large amounts of di-
gital data.

SDRAM Synchronised access RAM.

Strain gauge See Electric resistance extensometer.

USB Universal Serial Bus, serial  communica-
tion and feeding standard created to con-
nect peripherals to computers.
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GENERAL

Overview of the solution and functionalities

Architecture

GF_VEDO SL is the complete process and automation con-
trol solution, which allows sequence control, process mana-
gement, programming and display of data and connectivity 
with a single modular system. 
To this end, a combination of “technological functions”, 
such as the management of PWM, fast counters, data filing 
by data logger, temperature PID, data export via FTP, ena-
bling the rapid creation of applications, is made available.

Controller and Operator Panel integrated into a single devi-
ce, complete with PLC embedded run time, available with 
a 3.5” or 7” wide display (the latter in either a horizontal or 
vertical version).

Thanks to its flexibility and ease of use can be used in a va-
riety of sectors and for numerous process and automation 
process controls, such as:
•	 the wood industry (gluing, etc.);
•	 packaging (packing, labelling, etc.);
•	 food industry (pasteurisers, etc.);
•	 chemical industry (autoclaves, etc.);
•	 metal working (washing, etc.);
•	 plastic working (dryers, coolers, etc.).

Figure 1 - System architecture

CANopen

RS232

RS485 USB
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SD card

Modbus/RTU

Modbus/TCP
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GF_VEDO series SL models 35CT – 70CT – V70CT

The integrated Controller and Operator Panel allows the 
complete management of automation.
Available in 3 versions (6 models), and equipped with a po-
werful 400 MHz processor.
It is destined mainly to operate in an industrial environment 
on the control panels of production process machines or 
processes.

The operator interacts through a colour touch screen. 
Depending on the model, the size of the screen is 3.5” or 
7” wide. 
As an option, the device can be equipped with programma-
ble function buttons.

Thanks to its numerous communication ports (some of 
which are optional), it is possible to connect a wide range of 
devices to the controller, such as computers, barcode rea-
ders, USB sticks, modems, printers, etc., and connect it to 
an Ethernet network.

The remote input and output modules (CAN-IO) are con-
nected by bus to the CAN port (CANopen). 
Other CANopen standard compliant devices can also be 
connected to the bus.

Technical data

35CT 70CT – V70CT

POWER

Operating voltage 24 Vdc ±25%

Absorbed current
(at 24 Vdc)

300 mA max 350 mA max

Dissipated power 7,5 W max 8,5 W max

Protections Protection for polarity inversion
Short circuit 

Connection 3-pole polarised extractable connector
Screw terminals, max wire section  2,5 mm2

BACK-UP BATTERY

Type Rechargeable Li-Al 3 V 65 mA/h, type ML2032, 
non-replaceable

Duration 10 years
in absence of power: 20 months

CONNECTIONS

CAN port Opto-isolated
Connector: DB9 M
Speed: 10 kbit/s … 1 Mbit/s
Termination: to be managed externally

Ethernet port (ETH) Connector: RJ45
Speed: 10 / 100 Mbit/s
Signals: green connection LED, yellow data LED

RS-485 port (optional) Opto-isolated
Connector: DB9 M
Speed: 9,6 kbit/s … 115 kbit/s

RS-232 port (optional) Connector: DB9 M
Speed: 9,6 kbit/s … 115 kbit/s

USB port (optional) Connector: type A
Standard: USB 2.0
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35CT 70CT – V70CT

COMMUNICATION
PROTOCOLS

Ethernet FTP (File Transfer Protocol) 
Modbus TCP/IP Master/Slave

CAN CANopen Master

Modbus Modbus RTU Master/Slave

DISPLAY

Type TFT touch screen with 4-wires resistive technology 

Dimensions (diagonal) 3,5” 7”

Resolution in pixels 320 x 240 (QVGA) 70CT: 800 x 480 (WVGA)
V70CT: 480 x 800

Display area  (L x H) 70 x 52,5 mm 70CT: 152,4 x 91,4 mm
V70CT: 91,4 x 152,4 mm

Colours 262.000

Brightness 400 cd/m2 240 cd/m2

Contrast 400:1 1000:1

Backlighting White LEDs, duration 50.000 hours @ 25 °C

Visual angle Horizontal: 60°
Vertical: 45°-60°

70CT and V70CT: 85° in all
directions

CONFIGURATION 
ELEMENTS

Procedure software access 16-position dial

CONTROL
ELEMENTS

Keypad (optional)
6 programmable function 
buttons

10 programmable function 
buttons

MICROPROCESSOR
Type ARM9

Frequency 400MHz

MEMORY

Sistem 64 MB, tipo SDRAM
•	 12 MB HMI application
•	 2,5 MB PLC applicative

Retentive •	 32 kB retentive variables  (FLASH / FRAM *)
•	 1 MB data logger (FLASH)

Mass 128 MB, tipo FLASH
•	 32 MB for user

Mass extension Slot SD Card (optional) *

ENVIRONMENTAL
CONDITIONS

Operating temperature 0 ... +50 °C (according to IEC 68-2-14)

Storage temperature -20 ... +70 °C (according to IEC 68-2-14)

Relative humidity max 95% RH non condensing  (according to IEC 68-2-3)

ASSEMBLY Embedded, in control panels

DEGREE OF PROTECTION IP 65 on the front  (according to IEC 68-2-3)

WEIGHT 0,25 kg 0,5 kg

CE STANDARDS

EMC conformity
(electromagnetic 
compatibility)

Observance of Directive 2004/108/CE
EMC Emission: EN 61000-6-4
EMC Immunity EMC: EN 61131-2, EN 61000-4-2, EN 
61000-4-3, EN 61000-4-4, EN 61000-4-5, EN 61000-4-6, 
EN 61000‑4‑8, EN 61000-4-11

LV conformity
(low voltage)

Observance of  2006/95/CE
Safety LVD: EN 61010-1

* Available from January 2013
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Dimensions and spaces required for installation

Figure 2 - Dimensions GF_VEDO SL
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Attention: the temperature inside the compartment 
that houses the integrated Controller and Operator 
Panel must never exceed  50 °C.

The free spaces highlighted in grey are those recommended 
with static ventilation. 
With forced ventilation these spaces can be reduced even 
further.

Figure 3 - Free spaces for ventilation
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ASSEMBLY AND INSTALLATION

Assembly of Integrated Controller and Operator Panel

Hole dimensions
For correct installation, observe the dimensions of the
templates shown in the illustration.
The dotted line shows the maximum size of the front panel.

Attention: the panel on which the Integrated Controller and 
Operator Panel is mounted has to have the following cha-
racteristics:
•	 be sufficiently stiff and strong so that it does not bend 

during use;
•	 be between 1 and 12 mm thick, to allow the fastening of 

the device with the terminals supplied;
•	 if the use of the USB transfer cable is envisaged, read 

the notes on its installation first.

93

93

187.5

12
4

18
7.

5

124

GF VEDO SL V70CTGF VEDO SL V70CTGF VEDO SL 35CT

Protection against infiltrations of 
water
The Integrated Controller and Operator Panel offers, first of 
all, a degree of protection of IP65. It is therefore possible to 
install the device in particularly dusty environments or areas 
subject to splashes of water without problems:
•	 the compartment in which the device is housed also 

has to be dust and  waterproof;
•	 the panel on which the device is installed must be per-

fectly smooth and flat on the front;
•	 the hole in the panel must scrupulously respect the di-

mensions  indicated;
•	 the device has to be fastened tightly to the panel, to 

allow the gasket fitted at the back to ensure water tight-
ness.

Vibrations
The Integrated Controller and Operator Panel can support 
vibrations up to 150 Hz:
•	 from 5 to 9 Hz: sinusoidal 3.5 mm constant;
•	 from 9 to 150 Hz: sinusoidal with acceleration equal to 

1 G.

Should the device be mounted on a support that exceeds 
these limits it is necessary to envisage a system for the su-
spension and mitigation of the vibrations.

Minimum spaces for ventilation
The temperature of the compartment that houses the Inte-
grated Controller and Operator Panel must not exceed 
50 °C. Figure 3 – Free spaces for ventilation shows the mini-
mum free distances recommended in the installation of the 
device in a closed compartment.

Positioning
The Integrated Controller and Operator Panel has to be po-
sitioned in order to guarantee the following conditions:
•	 the screen must not be directly lit by the sun or particu-

larly bright light sources.
•	 If necessary, screen direct rays, using an antiglare shut-

ter for example;
•	 there must be no sudden temperature changes;
•	 there must be a low explosion risk: it can be connected 

to elements that operate in environments with a hazar-
dous atmosphere (flammable or explosive) only through 
appropriate and suitable types of interface, compliant 
to the safety standards in force;

•	 low presence of magnetic fields

Figure 4 - Panel hole dimensions for GF_VEDO SL
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120°

45°

The angulation of the controller must be between 45° and 
120°, as shown in  figure 5.

Figure 5 - GF_VEDO SL admitted angulation

Figure 7 - Assembly of seal, metal bracket and terminal connection

Figure 6 - Position and angulation

The angulation to choose also depends on the position of the 
controller compared to the operator, as shown in  figure 6.

Fastening to the panel
Fit the die-cut rubber seal in the back of the Integrated Con-
troller and Operator (figure 7).
The seal, supplied as standard, is essential to guarantee 
IP65-rated protection.

With GF VEDO SL 70CT and GF VEDO SL V70CT, fit the two 
metallic brackets supplied into the special housings on the 
short sides and fasten them in place with the screws (figure 
7).

GF VEDO SL 35CT
GF VEDO SL 70CT

GF VEDO SL V70CT

Figure 8 - Positions available for fastening terminals

Fit the Integrated Controller and Operator in the panel, con-
nect the 4 terminals supplied to the device and tighten the 
screw until the device is fastened tightly to the panel.

There are 4 positions in which to connect the terminals, two 
per side.
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Integrated Controller and Operator Panel Connections

Inputs, ports and signals

1

7 6

2 9

4

38

5 5

1 2 938

4

7 6

GF VEDO SL 35CT GF VEDO SL 70CT
GF VEDO SL V70CT

N. Description Connector / indicator Note

1 Input power 24 Vdc ± 25% Pull-out polarised terminal block

2 CAN Port DB9 M (D-sub 9 pin male)

3 Ethernet Port 10/100 Mbit/s RJ45

4 USB Port USB Type A optional

5 SD Card Slot optional

6 RS232 Port DB9 M (D-sub 9 pin male) optional

7 Insulated RS485 Port DB9 M (D-sub 9 pin male) optional

8 Green “Link” LED Permanently on signals that the 
Ethernet connection is active

9 Yellow “Data” LED Flashing signals that data is being 
transferred

A high-speed transfer could 
make the yellow LED appear 
permanently on

Figure 9 - GF_VEDO SL connector position

Power

The Integrated Controller and Operator Panel must be con-
nected to a 24 Vdc power supply unit.
The same 24 Vdc power supply can feed several devices 
(controller and CAN-IO modules).
Make sure that the current issued by the power supply is 
higher than the total maximum current absorbed by all the 
devices connected.

Figure 10 - GF_VEDO SL power

Considering that the device has no switch, it is necessary to 
install one before it, with a protective fuse.
The switch has to be positioned in the immediate vicinity of 
the device and be easy for the operator to reach.

For the 24 Vdc power supply, use a separate line from that 
used for electromechanical power devices such as  relays, 
contactors, solenoids, etc.
If there are considerable changes in the mains voltage, use 
a voltage stabiliser.
Near to high frequency generators or arc welders, use ade-
quate grid filters.

Connect the power cables to the power connector. Fit the 
cylindrical nucleus in ferrite, supplied with the product, as 
close as possible to the device to limit the susceptibility of 
the device to electromagnetic disturbance (figure 11).

The 24 Vdc power cables must follow a separate route from 
the power cables of the system or the machine.

230 Vac 24 Vdc 
- 
+ 
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Attention: make sure that the earth connection is
efficient. A non-existent or inefficient earth con-
nection can make the operation of the device
unstable, due to excessive environmental.
In particular, check that:
•	 the voltage between ground and earth is < 1 V;
•	 the ohm resistance is  < 6 Ω.

CAN
Connect the cable for the CAN field bus (CANopen protocol). 
The CAN bus connects the various CAN devices, such as 
the CAN-IO modules, to the Integrated Controller and Ope-
rator Panel.
Considering that the CAN port is opto-isolated, it is not ne-
cessary to disconnect the power to the device before con-
necting it.
For the wiring of the line, use an approved cable.
Fasten the cable connector to that of the controller with the 
appropriate screws.

1

9

Pin Name Description

1

2 CAN_L CAN-Low (CAN-)

3 GND Ground (mass)

4

5 EARTH Earth

6

7 CAN_H CAN-High (CAN+)

8

9

Figure 11 - GF_VEDO SL power connection

Figure 12 - CAN bus line termination

The line termination is not fitted in the controller.
It is therefore necessary to fit two terminations 
(resistor 120 Ω, ¼ W, 5%) at the ends of the CAN 
bus, as shown in figure 12.

Note: If the last device of the CAN bus is a CAN-IO module, 
it is possible to activate the termination in the module with 
the appropriate switches (see the CAN-IO documentation).

Ethernet
If necessary, connect the Ethernet cable to the Ethernet 
RJ45 port. 
The Ethernet port allows connection of the Integrated Con-
troller and Panel to a computer or to a company LAN net-
work. 
The connection cable to use (either straight or crossover) 
depends on the type of device that has to be connected. 
For example, to directly connect a PC it is necessary to use 
a crossover cable.

1
2
3
4
5
6
7
8

1
2
3
4
5
6
7
8

1
2
3
4
5
6
7
8

1
2
3
4
5
6
7
8

Straight cable Crossover cable

Figure 13 - straight and crossover Ethernet cables 

For the connection, use a CAT6 UTP cable or superior.
The maximum length of the Ethernet cable is 100 metres.

Do not run the Ethernet cable alongside the machine power 
cables, to avoid interference with data transmission.

The RJ45 socket has two LEDs. When the Ethernet connec-
tion is active, the green LED stays permanently lit; when data 
is being transmitted, the yellow LED flashes.

1   2   3

FERRITE

+24 Vdc ±25%
350 mA max+                 -

+VI24                  GNDI

12
0 

Ω

12
0 

Ω

1 2 n...

CAN_L

CAN_H
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USB
The USB port is optional and is used to connect external 
devices compliant to the USB standard.
The connector is Type A and the port supports version
USB 2.0, with speed up to 480 Mbit/s. 
The port is able to issue a current of 500 mA at 5 Vdc to 
power USB devices. 
The maximum length allowed for the  USB cable is 5 metres.

Transfer cable
It is possible to directly access the USB port of the controller 
from the panel using the transfer cable (accessory to order 
separately). 
To fit the socket of this cable, the panel thickness, in the 
position chosen, should not exceed  2 mm.

SD Card
The SD Card slot is optional and allows use of the SD Card 
mass memories to store data and applications.
The SD Card can be used and removed at will. 
Before removing it, make sure that there are no writing ope-
rations in progress.

RS232
The RS232 port is optional. Considering that the RS232 port 
is not insulated, it is necessary to disconnect the power to 
the Integrated Controller and Operator Panel and to the de-
vice to be connected before connecting them.  
The connection cable must be screened and not exceed a 
length of 5 metres.
Tighten the cable connector to that of the controller using 
the special screws.

1

9

Pin Name Description Signal Flow

1 DCD
Data Carrier 
Detect

Input

2 RxD
Received
Data

Input

3 TxD
Transmitted 
Data

Output

4 DTR
Data Terminal 
Ready

Output

5 GND Ground Mass

6 DSR
Data Set 
Ready

Input

7 RTS
Request To 
Send

Output

8 CTS
Clear To 
Send

Input

9 RI
Ring 
Indicator

Input

RS485
The RS485 port is optional. 
Considering that the RS485 is opto-isolated, it is not neces-
sary to disconnect the power to the Integrated Controller 
and Operator Panel and to the device to be connected be-
fore connecting them.
Tighten the cable connector to that of the controller using 
the special screws.

1

9

Pin Name Description

1

2 TX/RX+ Data +

3

4 TX/RX- Data -

5 GND Ground

6

7

8

9

The RS485 connection can be used successfully over long 
distances and in environments characterised by considera-
ble disturbance.
The maximum length of the cable depends on the transmis-
sion speed, as shown in figure 14.

Figure 14 - RS485 max transmission speed

1000 m

100 m

10 m

10 kb/s           100 kb/s           1 Mb/s           10 Mb/s

Max data transmission speed with AWG24 cable



1680991_MHW_GF_VEDO SL_10-2012_ENG

5.	 Shift the controller dial to its previous position.
6.	 Switch the controller again.  After the initial start phase, 

the application program screen appears.

Main Menu

The version of the set-up program installed appears in the 
top right corner.
The Configuration button allows access to the device con-
figuration procedures.
The Information button allows access to information on the 
firmware and communication protocols installed.
The Exit button allows a return to the application program, 
if installed.

Configuration

The HOME button in the top left corner allows a return to 
the Main Menu.
The Network button allows access to the device configura-
tion procedures.
The Display button allows access to information on the 
firmware and communication protocols installed.
The Touchscreen Calibration button will allow future ac-
cess to the procedure for the calibration of the touch
screen without using the dial.

ENTRY INTO SERVICE

When no application program has been uploaded onto the 
Integrated Controller and Operator Panel, or when the dial is 
positioned on F, the following happens:
1.	 The Gefran logo appears on the screen.

2.	 The operating system is loaded (this takes about 1mi).
3.	 The Main Menu of the set-up program appears.
The set-up program allows configuration of the device and 
to obtain information on it.

The configurations to be carried out when using the control-
ler for the first time are:
1.	 Regulation of the current date and time.
2.	 Calibration of the touchscreen display.
3.	 Uploading of the application program.
When uploading an application program onto the controller, 
the set-up program is no longer shown.

To access the set-up program again after uploading an ap-
plication program onto the Integrated Controller and Opera-
tor Panel, proceed as follows:
1.	 Switch off the controller.
2.	 Shift the controller dial to position F (figure  15) 

 
 
 
 

 
 
 
 

Figure 15 - GF_VEDO SL Dial

3.	 Switch the controller on again. After the initial start pha-
se, the main menu of the set-up program appears.

4.	 Operate as for the set-up program and then switch off 
the controller.

Set-up program

GF_VEDO SL 35CT GF_VEDO SL 70CT
GF_VEDO SL V70CT
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Display

On this screen it is possible to regulate the brightness and 
the screensaver timeout.
To regulate the  Brightness of the screen, use the - and + 
buttons. 
The 100% value (set in the factory) is ideal for most situa-
tions.
To regulate the Screen saver timeout use the - and + but-
tons. 120 seconds (set in the factory) is ideal for most situa-
tions. 
Setting 0 seconds, the screen never times out. 
It is advisable to set the shortest possible timeout, compati-
bly with your needs. 
To see the screen again, all you have to do is touch any 
button.
The Save button memorises the new configuration and the  
Cancel button cancels the changes and maintains the pre-
vious configuration parameters.
The HOME button in the top left corner allows a return to 
the Main Menu while the BACK button returns to the Confi-
guration screen.

Touchscreen calibration

To calibrate the touch screen, proceed as follows:
1.	 Switch off the device.
2.	 Position the dial on E.
3.	 Switch the device on again. The logo page is followed 

by the calibration screen. This screen is used to calibra-
te the response of the screen when it is touched with a 
finger.

4.	 Touch the 5 targets precisely with a plastic tip, following 
the order proposed on the screen

5.	 After touching the 5th target, the system automatical-
ly exits the calibration procedure and starts the set-up 
program or, if it exists, the application program.

6.	 Switch off the device.
7.	 Position the dial on 0.
8.	 Switch the device on again.

To regulate the date, proceed as follows:
1.	 Touch the year with a finger. The numeric keypad appe-

ars. Type in the year and press Enter. The changed year 
appears underlined.

2.	 Touch the month with a finger. The numeric keypad 
appears. Type in the month in the 2-figure format and 
press Enter. The changed month appears underlined.

3.	 Touch the day with a finger. The numeric keypad ap-
pears. Type in the day in the 2-figure format and press 
Enter. The changed day appears underlined.

4.	 Press SAVE to save the changes made. When the new 
date has been saved, the underlining disappears.

To regulate the time, proceed as follows:
1.	 Touch the hours with a finger. The numeric keypad ap-

pears. Type in the hour in the 24h format and press En-
ter. The changed hour appears underlined.

2.	 Touch the minutes with a finger. The numeric keypad 
appears. Type in the minutes in the 2-figure format and 
press Enter. The changed minutes appear underlined.

3.	 Touch the seconds with a finger.  The numeric keypad 
appears.  Type in the seconds in the 2-figure format and 
press Enter.  The changed seconds appear underlined.

4.	 Press Save to save the changes made. When the new 
time has been saved, the underlining disappears.

Attention: the controller does not automatically 
update the time when the clocks go back/forward.

The Save button memorises the new time and date and the 
Cancel button cancels the changes and maintains the pre-
vious time and date.

Network

On this screen it is possible to know and set the IP (IP Ad-
dress) and the Subnet Mask of the Integrated Controller 
and Operator Panel.
Selecting Enable DHCP the controller obtains the IP ad-
dress from a DHCP server connected to the network, other-
wise it uses the IP address saved by hand.
The Save button memorises the new configuration and the 
Cancel button cancels the changes and maintains the pre-
vious configuration parameters.
The HOME button in the top left corner allows a return to 
the Main Menu while the  BACK button returns to the Con-
figuration screen.
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Modbus TCP

This screen shows the  Node number of the Integrated Con-
troller and Operator Panel for the Modbus TCP protocol and 
information on the status of the Modbus TCP protocol.
The HOME button in the top left corner allows a return to 
the Main Menu while the BACK button returns to the Infor-
mation screen.

Modbus RTU

This screen shows the  Node number of the Integrated Con-
troller and Operator Panel for the Modbus RTU protocol and 
information on the status of the Modbus TCP protocol.
The HOME button in the top left corner allows a return to 
the Main Menu while the BACK button returns to the Infor-
mation screen.

Information

The HOME  button in the top left corner allows a return to 
the  Main Menu.
The CANopen, Modbus TCP and Modbus RTU buttons 
allow access to information relating to the various commu-
nication protocols.
The System Message button allows access to system in-
formation.
The screen directly shows the versions of Bootloader, 
Firmware, FileSystem and Runtime.

CANopen

This screen shows the node number of the Integrated Con-
troller and Operator Panel for the CANopen protocol and in-
formation on the status of the CANopen protocol.
Emergency information defines the number of times that 
the node has shown the state of emergency.
The HOME button in the top left corner allows a return to 
the Main Menu while the BACK button returns to the Infor-
mation screen.
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To upload the application program onto the Integrated Con-
troller and Operator Panel, proceed as follows:

1.	 Connect the controller to a PC using a crossover Ether-
net cable.

2.	 Open the Network screen of the set-up program, di-
sable the DHCP and manually set an IP address, e.g.: 
192.168.010.002.

3.	 Run the GF Project LX program on the PC.
4.	 Click the  Open code prj ... button.
5.	 Select the required PLC program from the list that opens 

(the file extension is .PPJS) and click the Open button.
6.	 Select -> Settings from the Communication menu.
7.	 Select the GDB protocol in the Device Link Manager 

Config window that opens.
8.	 Click the Properties button. The Gdb Config. Win-

dow opens. Select the TCP/IP protocol from the Port 
dropdown menu and enter the IP address indicated at 
step 2 of the procedure in the IP address box.

9.	 Click the OK button and then press OK again.
10.	 Check the connection. Select -> Connect  from the 

Connection menu. The PC connects to the controller. 
In the bottom right window the following words appear:  
CONNECT, in green, NO CODE in yellow.              If 
DIFFERENT CODE appears, this means that there is 
already an application program, different from the one 
you are trying to upload, on the controller.  If the word 
CONNECT does not appear, this means that communi-
cation related settings are incorrect. In particular, verify 
the IP address.

Uploading the application program

System Message / Fault

This screen shows useful information in the case of malfun-
ctions.
Reset after watchdog signal indicates whether the con-
troller restarts automatically after the program has been blo-
cked.
Last Fault indicates when the last malfunction occurred.
Fault address indicates the address of the application pro-
gram code which manifested the malfunction.  
PLC Loaded shows and signals the correct upload of the 
PLC software.
HMI Loaded shows and signals the correct upload of the 
application program.
The HOME button in the top left corner allows a return to 
the Main Menu while the BACK button returns to the Infor-
mation screen.

11.	 Upload the application onto the controller, selecting -> 
Download Code from the Communication menu. Click 
the Yes button in the warning message that opens. The 
transfer starts and is highlighted on a progress bar. 

12.	 At the end of the transfer, a window opens and asks you 
to restart the system. Click  Yes.

13.	 In the bottom left corner of the  Output panel there is a 
list of the results of the actions performed; the message  
SOURCE OK appears in the window at the bottom.

14.	 Click the  Open GF Project LX page button and wait 
for the page editor to open.

15.	 Open the page application, selecting the  OPEN page 
menu.

16.	 Select the page required (the file extension is PAJX)   
from the list and click the  Open button.

17.	 Select -> Communication settings from the Project 
menu.

18.	 Select the GDB protocol in the Device Link Manager 
Config window that opens.

19.	 Click the Properties button. The Gdb Config. Win-
dow opens. Select the TCP/IP protocol from the Port 
dropdown menu and enter the IP address indicated at 
step 2 of the procedure in the IP address box.

20.	 Click the  OK button and then press OK again.
21.	 Transfer the program, selecting   -> Download Project  

from the Project menu.
22.	 In the bottom left corner of the  Output panel there is a 

list of the results of the actions performed; and the first 
page of the program uploaded appears on the screen of 
the Integrated Controller and Operator Panel.

23.	 Remove the Ethernet cable. 

To upload a new program onto a controller that has already 
been programmed, follow the same procedure. 
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MAINTENANCE AND DIAGNOSTICS

Integrated Controller and Operator 
Panel
See the System Message screen of the set-up program.

Maintenance

Diagnostics

Integrated Controller and Operator 
Panel 
To clean the screen use a slightly damp soft cloth. 
Do not use chemical or abrasive products.
Disconnect the power supply before cleaning the Controller. 

Disposal
The Integrated Controller and Operator Pa-
nel and the CAN-IO module must be dispo-
sed of in compliance with the laws in force.  
Some of the components used in the devi-
ces may damage the environment unless di-
sposed of properly.
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ORDERING CODES

GF_VEDO SL ####  LX0  ##  ##  ##  ##  #

Model

3.5” display 35CT

7” horizontal display 70CT

7” vertical display V70CT

RS485 + RS232 Ports

Absent 00

serial RS485+RS232+slot SD card S1

Basic memory

FLASH 128 MB
DRAM 64 MB
FRAM 32 kB (1)

LX0

USB Port

Absent 00

USB U1

CAN Port

Absent 00

CANopen C1

Lexan

Gefran G

Open Frame 0

Custom C

Keypad

Absent 00

Present K1

(1) SD and FRAM Available from January  2013
(2) Ask for availability
(3) Mandatory port for use with remote IO

Code examples

GF_VEDO SL 70CT LX0 S1 C1 U1 00 G 7” display; CANopen, RS485, RS232 and USB ports; lexan Gefran; no keypad

GF_VEDO SL 35CT LX0 00 C1 U1 K1 C 3,5” display; CANopen and USB ports; lexan customized; 6-key keypad

Create the codes to suit the device configuration required

Integrated Controller and Operator Panel

1)

2)

3)
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Programming tool

GF_PROJECT LX
Development software that allows the writing of the application program for PLC with IEC1131 languages. 
Also allows the construction, in graphic mode, of the various pages of the user interface necessary to the application deve-
loped.
Via GF_PROJECT LX it is possible to connect to the device that will host the application to debug the program and upload 
the upgrades.

System requirements

Minimum Recommended

Operating system Windows XP SP2 or Windows Vista or 
Windows 7 (32 bit)

Windows 7 (64 bit)

Processor Intel Pentium 1 GHz Intel Core i5 2,5 Ghz or superior

RAM 2 GB 4 GB or superior

Free space on Hard Disk 2 GB 4 GB or superior

Graphic resolution XGA (1024 x 768 pixel) SXGA (1280 x 1024 pixel) or superior

Browser Microsoft Internet Explorer 8.0 Microsoft Internet Explorer 9.0 or superior

Ethernet port 1 RJ45

DVD player Yes

USB port 1 USB 2.0
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